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Как добраться до ModelSim?

Практически все современные программ-

ные инструменты, которые поставляют фир-

мы — производители микросхем, содержат

в своем составе средства для симуляции про-

ектов. То же можно сказать и о компаниях —

разработчиках программного обеспечения.

Их программные инструменты также содер-

жат в своем составе средства для симуляции

проектов. Часть этих программных продук-

тов имеет собственные встроенные симуля-

торы, другие программы — нет. Но практи-

чески все эти программы имеют возможность

подключать внешние симуляторы. Наиболее

часто для отладки проектов используют си-

мулятор ModelSim, который стал фактичес-

ки промышленным стандартом. Более пол-

ную информацию о программе можно полу-

чить на сайте фирмы Mentor Graphic [1] или

на сайте фирмы «Мегратек».

Как добраться до ModelSim в Quartus?

Для того чтобы получить информацию по

применению программы ModelSim совмест-

но с программой Quartus, обратитесь к [2].

Как добраться до ModelSim в ISE?

Для того чтобы получить информацию по

применению программы ModelSim совмест-

но с программой ISE, обратитесь к [3].

Как добраться до ModelSim 

в Actel Libero IDE?

Перед тем как непосредственно описывать

работу с симулятором ModelSim, необходи-

мо сделать небольшое описание: какие дей-

ствия надо выполнить в программе Actel

Libero IDE для начала симуляции проекта.

Для запуска симулятора ModelSim предвари-

тельно должен быть создан файл тестбенча.

Его можно сделать в текстовом редакторе, до-

бавив в каталог Stimulus в окне списка фай-

лов проекта или нажав кнопку WaveFormer

в окне на закладке Project Flow (рис. 1).

Файл, созданный в окне WaveFormer, бу-

дет автоматически добавлен в список файлов

для симуляции.

Кнопка Stimulus Editor позволяет добавлять

и удалять файлы для тестбенча (рис. 2).

Для добавления нового файла в список

файлов для тестбенча нажмите кнопку

Stimulus Editor и в открывшемся окне добавь-

те файл.

Для изменения списка файлов тестбенча

нажмите мышкой на стрелку в левом верх-

нем углу кнопки Stimulus Editor и в раскрыв-

шемся списке выберете пункт Organize

Stimulus. В открывшемся окне (рис. 3) добавь-

те или удалите файлы для симуляции.

Для запуска симуляции нажмите кнопку

ModelSim (рис. 4).

Программа Actel Libero IDE позволяет си-

мулировать исходный проект (проекты) после

синтеза, размещения и трассировки кристал-

ла. Для выбора нажмите на стрелку в левом

верхнем углу на кнопке ModelSim и в раскрыв-

шемся списке выберите режим симуляции

(рис. 5).

Создание Verilog!модели 
цифровой системы

В этом разделе мы начнем проверять мо-

дели в симуляторе. В примере 1 показан файл

модуля, описывающий таймер. Таймер име-

ет разрядность, задаваемую параметром

Width, и по умолчанию она  равна 4. На тай-

мер поступают обычные сигналы: Clk — сиг-

нал системной синхрочастоты и Reset — сиг-

нал асинхронного сброса. Таймер загружает-

Краткий курс HDL. 

Часть 8. 

Моделирование в ModelSim SE

Продолжение. Начало в № 3`2008

Рис. 1. Создание файла тестбенча

Рис. 2. Кнопка Stimulus Editor

Рис. 3. Окно Organize Stimulus

Рис. 4. Для запуска симуляции 

необходимо нажать кнопку ModelSim

Рис. 5. Выбор режима симуляции
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ся данными, поступающими по шине Data

при наличии разрешающего сигнала Load.

Выходные сигналы — Out — это шина счет-

чика и сигнал Time, показывающий оконча-

ние счета и, следовательно, то, что выдержка

времени завершена.

/////////////////////////////////////////////////////

// Name File : Timer4.v //

// Autor : Iosif Karshenboim //

// Company : //

// Description : Timer, Width=4 bits //

// Start design : 16.10.2003 //

// Last revision : 16.10.2003 //

/////////////////////////////////////////////////////

`timescale 1ns / 10 ps

module Timer4 

// These parameters can be overridden

#( parameter Width=4) 

( Out, 

Time, 

Load, 

Data, 

Clk, 

Reset);

output [Width-1:0] Out;

output Time;

input [Width-1:0] Data;

input Load;

input Clk;

input Reset;

reg [Width-1:0] Out;

Reg Time;

//-----------------------------------

always @(posedge Clk or posedge Reset)

if (Reset)

Out = 0;

else

if (Load & Time)

Out = Data;

else

if (!Time) 

Out = Out-1; // decrement(count)

else

Out = Out; // hold

//-----------------------------------

always @(posedge Clk or posedge Reset)

if (Reset)

Time =1'b1;

else

if (Out[Width-1:1]==0)// time OK

Time =1'b1;

else

Time = 1'b0;

//-----------------------------------

endmodule

Пример 1. Файл модуля, 

содержащий описание таймера

В примере 2 приведен файл простейшего

тестбенча для проверки модуля Timer4. Одна-

ко проверка данного модуля — это только

первый и довольно простой шаг, поэтому мы

сразу перейдем к следующему файлу. В при-

мере 3 приведен файл STATMACH.v, в кото-

рый установлен Timer4. Кроме того, в этом

же модуле дано описание статического авто-

мата. Задержка, вырабатываемая тайме-

ром, — фиксированная и задается в строке:

reg [4:0] tmr_delay = 5;

Автомат выполняет переход только по по-

лучении сигнала от таймера:

if(tmr_ready)

state = next_state;

Пример 3 показывает, как можно выпол-

нить программируемую задержку для стати-

ческих автоматов. Обратите внимание на то,

что в файле STATMACH.v нет строки:

`timescale 1ns / 10 ps

Отсутствие данной директивы приведет

в дальнейшем к тому, что симулятор выдаст

предупреждение об этом.

`timescale 1ns / 10 ps

module test_timer;

parameter TWidth=4;

reg Clk, Reset, Load;

reg [TWidth-1:0] Data;

wire [TWidth-1:0] Out;

Timer4 #(.Width (TWidth)) 

dut (Out,

Time,

Load,

Data,

Clk,

Reset);

initial // Clock generator

begin

Clk = 0;

#10 forever #10 Clk = !Clk;

end

initial // Test stimulus

begin

Reset = 0;

#10 Reset = 1;

#40 Reset = 0;

Data=4'b0011;

Load = 0;

#90 Load = 1;

#200 Load = 0;

#50000 $stop;

end

initial

$monitor($stime, Reset,Data, Clk,Time,Load, Out); 

endmodule

Пример 2. Файл простейшего тестбенча 

для проверки модуля Timer4

/////////////////////////////////////////////////////////////////

// Name File : STATMACH.v //

// Autor : Iosif Karshenboim //

// Company : //

// Description : Timer, Width=4 bits and FSM //

// Start design : 16.10.2003 //

// Last revision : 16.10.2003 //

/////////////////////////////////////////////////////////////////

module statmach

(clk,

reset, 

in, 

out);

input clk; 

input [3:0] in; 

input reset;

output [4:0] out;

reg [4:0] out;

reg [3:0] state, next_state;

wire tmr_ready;

reg tmr_load = 1; 

reg [4:0] tmr_delay = 5; 

parameter s0 = 0, s1 = 1, s2 = 2, s3 = 3;

// FSM register

always @(posedge clk or posedge reset)

begin: statreg

if (reset)

state = s0;

else

if (tmr_ready)

state = next_state;

end

// FSM conbinational block

always @(state) 

begin: FSM

case (state)

s0: next_state = s1;

s1: next_state = s2;

s2: next_state = s3;

s3: next_state = s0;

endcase

end

always @(state) 

begin: outputs

case (state)

s0: out = 5'b00011;

s1: out = 5'b00110;

s2: out = 5'b01100;

s3: out = 5'b11000;

default: out = 5'b11111;

endcase

end // outdata

Timer4 #(5) TIMER // These parameters can be overridden

(.Out (),

.Time (tmr_ready),

.Load (tmr_load),

.Data (tmr_delay),

.Clk (clk),

.Reset (reset));

endmodule

Пример 3. Файл STATMACH.v, 

в который установлен Timer4, и в этом же модуле 

дано описание статического автомата

Теперь переходим к файлу тестбенча для

проверки модуля STATMACH.v. 

В примере 4 приведен файл tstatmach.v,

в который установлен модуль STATMACH.v.

В примере 5 приведен файл паттернов для

тестбенча по проверке модуля STATMACH.v.

Основная цель данного примера — показать

то, как производится чтение данных из фай-

ла паттерна и как эти данные можно исполь-

зовать при симуляции. В файле паттернов

в каждой строке считываются различные по

формату данные.

Работа с файлами 
и примеры отладки

Итак, в примере 4 приведен файл tstat-

mach.v. А в примере 5 приведен файл паттер-

нов для тестбенча по проверке модуля tstat-

mach.v. В данном примере тестбенча мы бу-

дем производить чтение данных из файла

паттерна, а полученные данные — использо-

вать при симуляции. В файле паттернов

в каждой строке считываются различные по

формату данные — это time, bin, dec и hex.

В приведенном примере из этих данных в тест-

бенче будут использоваться только первые две

переменные — time и bin, а остальные пере-

менные — dec и hex — будут считываться,

но не будут использоваться в тестбенче.

Тестбенч состоит из трех фрагментов, на-

чинающихся с initial.

Первый фрагмент формирует синхрочас-

тоту, подаваемую на DUT. Это можно  сде-

лать при помощи выражения:

#10 forever #10 clk = !clk;

www.kit!e.ru
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Второй фрагмент формирует сигнал «сброс»,

подаваемый на DUT. Это делается при помо-

щи трех выражений:

reset = 0;

#10 reset = 1;

#30 reset = 0;

Третий фрагмент формирует все осталь-

ные сигналы, подаваемые на DUT. Это дела-

ется в блоке file_block.

Файл, определенный как INPUT_FILE_

NAME “vectors.pat”, открывается только для

чтения. Если файл открылся успешно, то в цик-

ле while (c != ̀ EOF) производится считывание

строк файла паттерна до тех пор, пока не бу-

дет обнаружен конец файла. При считывании

строк паттерна выполняется проверка на то,

что данная строка не заремаркирована. Снача-

ла производится считывание первого симво-

ла строки паттерна. Это производится в стро-

ке файла if (c == “/”), и, если это условие вы-

полняется, то считывается вся строка

паттерна: r = $fgets(line, file), но эти данные

не используются. Если же первый считанный

символ не равен “/”, то он возвращается

в строку. Далее из строки паттерна считы-

вается значение времени. Проверяется,

не обогнало ли текущее время моделирова-

ния время, читаемое из паттерна. Затем про-

грамма выполняет задержку, так, чтобы теку-

щее время моделирования стало равным тому

значению времени, которое мы прочли из пат-

терна. И после этого считываются все осталь-

ные данные из паттерна. Бинарные данные,

считываемые из паттерна, имеют разрядность

4 бита. Но из этих 4 битов в тестбенче исполь-

зуется только младший бит. И его значение

назначается регистру:

in = bin[0];

По окончании работы с паттерном файл

закрывается. При изменении значений пере-

менных, командой $display на монитор вы-

водятся значения этих переменных.

/////////////////////////////////////////////////////

// Name File : tstatmach.v //

// Autor : Iosif Karshenboim //

// Company : //

// Description : Testbench //

// Start design : 16.10.2003 //

// Last revision : 16.10.2003 //

/////////////////////////////////////////////////////

`timescale 1ns / 10 ps

`define EOF 32'hFFFF_FFFF

`define NULL 0

`define MAX_LINE_LENGTH 1000

`define INPUT_FILE_NAME “vectors.pat”

module test_statmach;

reg clk, reset, in;

reg [31:0] tmp_value;

wire out;

statmach

dut (clk, in, reset, out);

initial // Clock generator 

begin

clk = 0;

#10 forever #10 clk = !clk;

end

initial // Test stimulus

begin

reset = 0;

#10 reset = 1;

#30 reset = 0;

end

integer file;

reg [31:0] c, r;

reg [3:0] bin;

reg [31:0] dec, hex;

real real_time;

reg [8*`MAX_LINE_LENGTH:0] line; /* Line of text read from file */

initial

begin : file_block 

/*timeformat_task ::= $timeformat [(units_number,

precision_number,

suffix_string,

minimum_field_width) ] ; */

$timeformat(-9, 3, “ns”, 6);

file = $fopen(`INPUT_FILE_NAME, “r”);

if ((file != `EOF) & (file != 0))

$display(“The input file was opened successfully.”);

else

begin

$display(“ERROR: unable to open the input file.”);

$finish;

end

// if (file == `NULL) // If error opening file

// disable file_block; // Just quit

c = $fgetc(file);

$display(“time bin decimal hex”);

while (c != `EOF)

begin

/* Check the first character for comment */

if (c == “/”)

r = $fgets(line, file);

else

begin

// Push the character back to the file then read the next time

r = $ungetc(c, file);

r = $fscanf(file, “%f:\n”, real_time);

// Wait until the absolute time in the file, then read stimulus

if ($realtime > real_time)

$display(“Error — absolute time in file is out of order —

%t”, real_time);

else

#(real_time — $realtime)

r = $fscanf(file,” %b %d %h\n”,bin,dec,hex);

//-----------------------------------------------

in = bin[0]; 

//-----------------------------------------------

end // if c else

c = $fgetc(file);

end // while not EOF

$fclose(file); 

$stop;

end // initial

//=============================================

// Display changes to the signals

//=============================================

always @(bin or dec or hex)

$display(“%t %b %d %h”, $realtime, bin, dec, hex);

endmodule // read_pattern

Пример 4. Тестбенч — модуль test_statmach, 

файл tstatmach.v

// This is a pattern file

// time bin dec hex

0 : 0001 1 1

10 : 0001 1 1

20.0 : 0010 20 020

50.02 : 0111 5 FFF

62.345 : 0100 4 DEADBEEF

75.789 : 0XX1 2 ZzZzZzZz

200.0 : 0010 20 020

400.0 : 1010 25 F2A

Пример 5. Файл паттернов для тестбенча tstatmach.v

Моделирование тестбенча

Для моделирования будем использовать

программу ModelSim, ставшую за последнее

время промышленным стандартом. Первым

шагом будет создание проекта. После запус-

ка программы ModelSim SE открывается ос-

новное окно программы (рис. 6).

Для того чтобы начать моделирование, не-

обходимо создать новый проект. Для этого

в главном меню выбираем File→New→Project.

Появится окно Create Project.

Для создания проекта выполним следую-

щие шаги: нам необходимо указать имя про-

екта и путь к файлам проекта, название ра-

бочей библиотеки:

1. В окне Project Name укажем имя проекта

(My_testbench).

2. В окне Project Location укажем рабочую ди-

ректорию (E:/My_testbench).

3. В окне Default Library Name оставим имя

work.

4. Нажмем OK (рис. 7).

Если пользователь программы захочет по-

вторно создать проект с тем же именем, в той

же рабочей директории, то программа выдаст

предупреждение о том, что проект с этим

именем уже существует. Если мы не хотим

менять имя проекта, и старый проект нам не

нужен, то в таком случае в этом окне необхо-

димо указать «Да» (рис. 8).

Рис. 6. Основное окно системы моделирования

ModelSim SE

Рис. 7. Задание имени проекта, 

пути к файлам проекта и название рабочей библиотеки
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Если же файлов для проекта еще нет,

то в открывшемся окне выбираем пункт

Create New File. Откроется окно для ввода

текстовых файлов. И далее создаем файлы

проекта один за другим. Если файлы для дан-

ного проекта уже имеются, то в открывшем-

ся окне Add Items to the Project выбираем Add

Existing File (рис. 9).

После выбора Add Exiting File появится ок-

но Add file to Project (рис. 10).

Добавляем файлы в проект либо по очере-

ди, либо это можно сделать одновременно,

если отметить сразу несколько файлов. В ок-

не Workspace поочередно появляются имена

добавляемых файлов проекта (рис. 11). Фай-

лы будут расположены в том порядке, в ко-

тором они были добавлены в проект. Но для

работы компилятора необходимо указать ие-

рархию файлов. Это можно сделать либо

вручную, либо автоматически.

Чтобы установить порядок компиляции

файлов вручную, необходимо учесть, что ком-

пиляция осуществляется согласно иерархии

описания проекта, и сначала на компиляцию

должны поступать следующие файлы: 
•• описания модулей нижнего уровня (в при-

мере это описание Timer4.V);
•• затем описания модулей верхнего уровня, со-

держащие установленные модули, которые

описаны в модулях нижнего уровня, и т. д.

(в примере это описание STSTMASH.v);
•• последний файл — это тестбенч.

Выберем второй путь. Для этого в главном

меню надо выбрать Compile→Compile Order,

далее появится окно Compile Order. 

Итак, выбираем Auto Generate и после это-

го нажимаем OK. Если файлы не содержат

ошибок, то компилятор выдаст в нижнем ок-

не Transcript соответствующие сообщения.

В данном примере эти сообщения имеют вид,

представленный на рис. 12.

В окне Workspace напротив имен файлов

знак вопроса после компиляции заменяем на

«галочку» (рис. 13).

Если программа содержит ошибку, то в ни-

жнем окне Transcript появится сообщение об

этом.

Двойной щелчок на сообщении об ошиб-

ке выдает строку Verilog-текста, в которой

может быть ошибка (однако на самом де-

ле ошибка может быть совершенно в дру-

гой строке — синтаксис Verilog сложный,

и так же, как и компиляторах языка Си,

ошибка может быть в строке перед указан-

ной строкой).

Выдача текста Verilog-файла для редак-

тирования осуществляется после двойно-

го щелчка по имени соответствующего

файла.

Далее переходим к заданию опций моде-

лирования. Для этого в главном меню необ-

ходимо выбрать: Simulate→Runtime Options,

появится окно Runtime Options. Задать:
•• Default Radix→Symbolic (формат представ-

ления данных);
•• Default Run→100 ns (время одного шага

моделирования при пошаговом моделиро-

вании);
•• Iteration Limit→5000 (число событий мо-

делирования, событие — изменение сиг-

нала).

Остальное — по умолчанию, нажать OK

(рис. 14).

Следующим шагом будет установка верх-

него модуля проекта для симуляции в окне

Start Simulation. Выбрать в главном меню

Simulate→Start Simulation, появится окно

Start Simulation (рис. 15).

В окне Start Simulation необходимо выпол-

нить следующие установки: раскрыть биб-

лиотеку work, выбрать (двумя щелчками)

имя верхнего модуля проекта (test_statmach),

остальное можно оставить по умолчанию.

Нажать OK (рис. 16).

После выбора верхнего модуля проекта

в окне Workspace появится закладка sim,

и внешний вид программы будет такой, как

на рис. 17.

При загрузке скомпилированных файлов

будут выданы следующие сообщения (рис. 18).

Первое из этих сообщений говорит о том,

что один из файлов проекта не содержит ди-

www.kit!e.ru

Рис. 8. Подтверждение имени проекта

Рис. 9. Добавление файлов в проект 

в окне Add Items to the Project

Рис. 10. Окно для выбора добавляемого 

в проект файла

Рис. 11. Файлы в проект добавлены Рис. 13. Компиляция файлов проекта проведена

Рис. 14. Задание опций моделирования 

в окне Runtime Options

Рис. 15. Окно Start Simulation 

для указания верхнего модуля проекта

# reading C:\FPGAdv63PS\Modeltech6\win32/../modelsim.ini

# Loading project My_testbench

# Compile of tstatmach.v was successful.

# Compile of STATMACH.V was successful.

# Compile of Timer4.v was successful.

# 3 compiles, 0 failed with no errors.

Рис. 12. Сообщения компилятора
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рективы `timescale, а два других — о том, что

часть портов вывода одного из модулей за-

действована лишь частично.

Следующим шагом будет открытие окна

Wave. Для этого в окне Workspace, в заклад-

ке sim, выделим строку с названием модуля

верхнего уровня test_statmach. Теперь клик-

нем правой клавишей мышки по этой стро-

ке и в открывшемся меню выберем строку

Add→Add to Wave. При этом откроется окно

Wave и в него будут загружены названия сиг-

налов модуля test_statmach. Внешний вид

этого окна программы показан на рис.19.

Выполним команду Run All. Это можно

выполнить, нажав кнопку . При выполне-

нии программы симулятор выдаст сообще-

ния (рис. 20).

Появилось сообщение о том, что симуля-

ция закончилась по команде $stop, находя-

щейся на строке 103, в файле tstatmach.v.

Теперь в окне Wave появились временные

диаграммы (рис. 21).

Необходимо заметить, что, выполнив ко-

манду Run All, можно получить временную

диаграмму, которая будет иметь неудобный

для визуального восприятия масштаб. Воз-

можно, диаграмма будет или сильно сжата,

или, наоборот, растянута. Поэтому она ви-

зуально может не восприниматься как пра-

вильно выполненная. Чтобы изменить мас-

штаб по времени для временных диаграмм,

можно воспользоваться кнопками для изме-

нения масштаба. Кнопка — «увеличить

масштаб», кнопка — «уменьшить мас-

штаб».

Если по каким-либо причинам моделиро-

вание не останавливается при симуляции фай-

ла, то такое бесконечное (зациклившиеся) мо-

делирование можно остановить командой

главного меню Simulate→Break, либо нажа-

тием кнопки Break . Во время работы симу-

лятора текущее время моделирования непре-

рывно увеличивается, и текущее время выво-

дится внизу окна Wave.

Если мы хотим перезапустить симуляцию,

то сначала нам необходимо будет выполнить

Restart. Для этого нажимаем кнопку Restart .

Откроется окно Restart (рис. 22). После на-

жатия на кнопку Restart в этом окне програм-

ма снова вернется в основное окно, при этом

диаграммы сигналов будут очищены.

Теперь можно добавить еще несколько ди-

аграмм в окно Wave.

В окне Workspace выделим строку dut —

это наш проверяемый модуль. В меню выпол-

нить комапнды Add→Wave→Selected Instance.

В результате этих действий сигналы компо-

нента dut, установленного в модуле test_stat-

mach, будут добавлены в окно Wave.

После этого можно снова нажимать кноп-

ку Run. Симулятор вновь выполняет модели-

рование (рис. 23) и при этом в окне Transcript

Рис. 16. Выбран модуль верхнего уровня

Рис. 17. Проект для моделирования прочитан 

без ошибок

Рис. 19. Окно временных диаграмм

Рис. 21. Сигналы для модуля test_statmach

изображены в окне Wave

Рис. 22. Меню в окне Restart

Рис. 23. Наблюдаемые сигналы 

для модулей test_statmach и dut в окне Wave

vsim work.test_statmach

# vsim work.test_statmach 

# Loading work.test_statmach

# Loading work.statmach

# ** Warning: (vsim-3009) [TSCALE] — Module 'statmach' does not have a `timescale directive in effect, but previous modules do.

# Region: /test_statmach/dut

# Loading work.Timer4

# ** Warning: (vsim-3015) E:/My_testbench/tstatmach.v(17): [PCDPC] — Port size (4 or 4) does not match connection size (1) for port 'in'.

# Region: /test_statmach/dut

# ** Warning: (vsim-3015) E:/My_testbench/tstatmach.v(17): [PCDPC] — Port size (5 or 5) does not match connection size (1) for port 'out'.

# Region: /test_statmach/dut.

run -all

# The input file was opened successfully.

# time bin decimal hex

# 0.000ns 0001 1 00000001

# 20.000ns 0010 20 00000020

# 50.020ns 0111 5 00000fff

# 62.340ns 0100 4 deadbeef

# 75.790ns 0xx1 2 zzzzzzzz

# 200.000ns 0010 20 00000020

# Break at E:/My_testbench/tstatmach.v line 103

# time bin decimal hex

# 0.000ns 0001 1 00000001

# 20.000ns 0010 20 00000020

# 50.020ns 0111 5 00000fff

# 62.340ns 0100 4 deadbeef

# 75.790ns 0xx1 2 zzzzzzzz

Рис. 18. Сообщения компилятора

Рис. 20. Сообщения компилятора

Рис. 24. Сообщения при выполнении программы
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выдаются сообщения (рис. 24).

Какие цели достигнуты в этом примере?

1. Показано, как создаются, устанавливают-

ся и используются модули разных уровней.

В этом примере есть модули трех уровней.

Показано, как передавать параметры в ус-

тановленный модуль. Показано, как при-

вязывать сигналы к установленному ком-

поненту.

2. Показано, как выполнять тестбенч с при-

менением файлов паттерна. Преимущест-

ва такого выполнения проектов в том, что

после изменений параметров в паттерне

нет необходимости выполнять компиля-

цию проекта. Надо просто использовать

Reset и запустить симуляцию.

3. Показано, как выводить на монитор ин-

формацию во время симуляции.

На этом моделирование примера будет

завершено. При выходе из системы модели-

рования в рабочей директории появятся

(рис. 25):
•• директория work (в ней находятся скомпи-

лированные файлы проекта);

•• системный файл My_testbench.mpf сохра-

ненного проекта цифровой системы (двой-

ной щелчок вызовет систему моделирова-

ния и загрузит сохраненное состояние про-

екта);
•• системный файл vsim.wlf временной диа-

граммы (двойной щелчок вызовет систе-

му моделирования и откроет окно Wave

с сохраненной временной диаграммой).

На этом описание работы с программой

ModelSim закончим. В этом разделе пока-

заны только самые необходимые действия

для первого ознакомления с работой про-

граммы. Автор не ставил себе целью пока-

зать все тонкости ее работы. Поэтому он

настоятельно рекомендует читателям само-

стоятельно провести более глубокое зна-

комство с руководством по использованию

программы ModelSim.

В следующем разделе мы рассмотрим во-

просы, связанные с использованием параме-

тров при написании файла модели. ■
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Рис. 25. Рабочая директория 

после сохранения проекта
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